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Chapter 1

Introducing Legacy Integrator SDK

Overview
The Legacy Integrator SDK (Software Development Kit) enables you to record TN3270,
TN5250, VT, and SSH terminal sessions and convert them to Java code. You can use
Java Beans generated by Legacy Integrator SDK to create Java solutions (applets,
applications, or program modules) that programmatically access and insert or extract
textual information from any terminal screen.
Legacy Integrator SDK includes a full-featured terminal emulator and session recorder
that make it easy to record terminal sessions. Just open Legacy Integrator SDK, connect
to a host, click Record, and begin your terminal session. As you interact with the host,
Legacy Integrator SDK records your session. When you are done recording, you can
automatically convert your session to Java code that contains API calls representing the
captured host interactions. You can then integrate the generated Java code into any Java
software system using the Legacy Integrator Runtime.
In addition to recording your session, the Legacy Integrator SDK allows you to insert or
extract text from terminal screens. Simply capture the screen coordinates and define a
variable while recording. You can then use this variable in your applet or application to
automatically get or put text in the specified screen location during runtime.
This guide describes the major features and functions of Legacy Integrator SDK, and
provides programming guidance for using the Java code you generate from your projects.
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System Requirements
This section provides information on system requirements specific to the installation of
Legacy Integrator.
Java version:

SDK: JDK or JRE 1.5 or higher
SDK Runtime: 1.5 or higher

Platforms Supported:

Windows
Linux
Any Java enabled platform

Note:

Red Oak Software does not support remote display using X Windows on any
platform.

Technical Support
If you experience problems with Legacy Integrator SDK, please contact Red Oak
technical support at:
1-877-660-4688
or email our technical support team at:
support@redoaksw.com
When contacting technical support, please be prepared to provide the following
information:
•

The names and models of the system you are using

•

The action that can reproduce the problem you are experiencing

•

Any error codes or exception traces received

•

Development environment

•

Operating system

•

JVM you are using
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Before You Begin
Legacy Integrator requires a software license key. The license key is distributed as a file.
There are several scenarios for receiving license key files:
•

When you purchase a Red Oak Software product that requires a license key, the
license key file is sent to you via email. This permanent license key is based on a
unique Host ID generated from the licensing system.

•

When you receive an evaluation copy of a Red Oak Software product that
requires a license key, the license key file is sent to you via email. Evaluation
license keys have expiration dates built into them.

Note:

You should have received your software license key via email.

You should get any keys you need before you attempt to install Legacy Integrator. To get
a key, please contact Red Oak Software at Info@redoaksw.com or 1-973-316-6064.
Note:

Please consult the product README file for the latest information regarding the
licensing process.

Importing the license key
The first time you launch Legacy Integrator you will be presented with the License Utility
dialog.
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To import your license key,

1. Press the “Edit License” button. This will display the Edit License dialog.

2. Enter the appropriate information for your Name and Organization.
3. To configure your license, press the “Import License Certificate” button. This will display the
file Open dialog.
4. Locate the Red Oak Software license key file and press “Open”. This will import the license
key and enable the software.
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Alternatively, you can manually type the license key directly into the “Key” text field.
Note:

Keep your license key in a safe place. You will need to present this to Red Oak
Software in the event you need software support.

Generating a Host ID file
Red Oak Software products are licensed using a unique Host ID generated from the
licensing system. To generate the unique Host ID for your installation,

1. Launch Legacy Integrator.
2. Locate and select the About menu item from the Help menu from the application main menu.
This will display the About dialog. Select the Info tab to display the product information panel.
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3. Press the “Edit License” button. This will display the License Utility dialog.
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Overview
Legacy Integrator SDK includes a full-featured terminal emulator and a session recorder
that makes it easy to record and modify TN3270, TN5250, VT, or SSH terminal sessions.
When you are done creating a project, you can automatically convert it to a Java Bean for
use in your Java applet or application.

User Interface
The Legacy Integrator SDK graphical interface provides multiple views of your project
and quick access to features and commands.
Menu bar
Toolbar

Action
Tree Panel

Terminal Panel

Attributes
Table

Status
Panel
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This section describes the Legacy Integrator SDK interface, including:
•

Action Tree Panel

•

Attributes Panel

•

Terminal Panel

•

Menu Bar and Context Menus

•

Toolbar

•

Status Panel

Action Tree Panel
The Action Tree panel displays the contents of your project in a hierarchical tree
structure. A Legacy Integrator SDK project can contain four kinds of objects:
•

Session object – Defines the connection and terminal attributes for all host
interactions in the project. Each project contains only one session object, which
is the root node of the Action Tree.

•

Variable objects – Define strings sent to, or extracted from, the host during
interaction sequences. Each project can contain multiple variable objects.

•

Sequence objects – Represent individual terminal sessions in the project. Each
sequence object contains action items that define the interaction with the host.
Sequence objects correlate with methods in the Java Bean generated from the
project.

•

Action items – The contents of sequence objects that specify interactions with
the host. Action items correlate with runtime calls within the methods in the Java
Bean generated from the project.
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Session object
Variable objects
Sequence objects

Action Tree Panel
Action items
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Attributes Table
The Attributes Table, which is located just below the Action Tree panel, displays the
attributes of any object selected in the Action Tree. It also allows you to modify the values
assigned to object attributes.
For example, the Attributes Table in the following figure displays attributes for the
LOC_Search session object selected in the Action Tree panel.

Selected Session
Tree Node

Action Tree
panel

Session Node’s
Attributes

Attributes
Table
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Terminal Panel
The Terminal Panel includes the terminal screen and the terminal keyboard. The terminal
screen emulates the “look and feel” and functionality of the host terminal screen. The
terminal screen also provides special functionality that extends beyond emulation. For
example, you can draw bounding boxes on the screen with your mouse pointer to define
areas from which to extract text during interaction with the host.
The terminal keyboard, located beneath the terminal screen, emulates the terminal
keyboard of the host to which you connect and provides simulation of function keys that
may not be available on a standard PC keyboard.

Status Panel
The Status Panel reports current activity of the Legacy Integrator SDK at the bottom of
the Legacy Integrator SDK window.

14
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Menu Bar
The menu bar at the top of the Legacy Integrator SDK window provides access to Legacy
Integrator SDK commands.

File Menu
Create new project
Open project
Close project
Save project
Name and save project
Close project and exit

Edit Menu
Add a new action
sequence to the selected
session object
Edit the value of the
selected variable object

Add a new variable to the
selected session object
Add a new action item to the
selected sequence object

Delete the selected object
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Edit – Add Action Item Menu

View Menu

Record Menu
Start recording
terminal interactions
Play back next action
item in the sequence

16

Toggles between
displaying field view
markers and displaying the
plain terminal panel

Start playing back recorded
terminal interactions
Stop recording
or playback
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Tools Menu
Generate Java Bean
from the current project

Trace Menu
Begin a trace process
Stop a running trace process

Help Menu
View information about
Legacy Integrator SDK
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Context Menus1
You can right-click on any one of the four kinds of objects in the Action Tree – session
objects, variable objects, sequence objects and action items – to display a context menu
for that object. The four kinds of context menus are described below.

Session Object Menu
Add a new action sequence
to the selected session

Add a new variable to
the selected session

Variable Object Menu
Edit the value of the
selected variable
Delete the selected variable

Sequence Object Menu
Delete the selected
sequence

1

Add a new action item to
the selected sequence

Due to Java Swing bug, Context Menus do not appear on the Solaris platform.
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Action Item Menu

Delete the selected
action item
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Add a new action item to
the sequence containing
the selected action item
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Toolbar
The Toolbar buttons at the top of the Legacy Integrator window provides single-click
access to the most frequently used commands.

Create new project

Generate Bean
Send keys to the host

Open existing project
Save project

Capture data from the screen

Delete selected
object in Action
Tree

Stop
Play next step
Play recorded session

Connect/disconnect
Toggle Field View
Markers

Record terminal session

20
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Overview
This chapter explains how to:
•

Manage projects

•

Use the terminal session recorder

•

Work with session, variable, sequence, and action item objects

•

Generate Java code from your project

Managing Projects
The following sections explain how to create, open, save, close, and modify a Legacy
Integration SDK project.

Opening an Existing Project

1. Click

.

If you have a currently open and unsaved project, you will be prompted to save it
before continuing.
The Open dialog box appears.
2. Select the file for the project you want to open and click Open.
The project is loaded into the Action Tree panel.

Creating a New Project

1. Click

.

If you have a project already open, you will be prompted to close and save it. You
can have only one Legacy Integrator SDK project open at a time.

22
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The New Project Dialog box appears.

2. In the New Project dialog box, specify project information:
•

You must specify connection information. The Host field is empty; you must
enter a value. Port defaults to 23; change it if necessary.

•

The project Description and LU Name fields are empty. You may enter
values, but they are not required in order to create the project.

•

Change other attribute defaults as necessary. All fields are editable.

3. When you are done specifying project information, click Create.
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A session object representing the project appears at the top of the Action Tree
Panel. You can select the session object to display its attributes in the Attributes
Table below the Action Tree.
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Saving a Project

1. Click

.

•

If you have previously saved the project, the project is saved with the same
file name and to the same location as previously specified.

•

If the project has not yet been saved, the Save dialog box appears and the
following steps apply.

2. Specify the folder in which you would like to save your project.
NOTE: If you have saved or opened a project previously, Legacy Integrator SDK
automatically locates that folder for you, making it easy to save all of
your files in one location.
3. Type a name for your project.
The default project name includes the .lip extension, to indicate that it is a Legacy
Integrator SDK project file. You may accept the default project name or type a
different name. The filename should have .lip extension when you type in a
different name. If you omit it, .lip will blindly be appended.
4. Click Save to save your file.
NOTE: To save a previously saved project under a new name, choose Save
As… from the File menu, type the new name in the Save dialog box, and
click Save.
If there is a preexisting file by the same name, that old file is backed up
to filename.lip.bak. Any preexisting backup file by that name is
overwritten.

Closing a Project
1. Choose Close from the File menu.
2. If your project contains any unsaved changes, you will be prompted to confirm
your choice:
•

Click Yes to save your project before closing.

•

Click No to close your project without saving it.

•

Click Cancel to abort the Close process and return you to your project.

Legacy Integrator SDK User’s Guide
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Modifying a Project
1. Open your project, if it is not already open.
The project is displayed in the Action Tree panel.
2. You may modify your project in the following ways:
•

Delete an existing sequence or add a newly recorded sequence. For more
information, see “Using the Recorder,” beginning on page 27.

•

To add or delete action items from an existing recording, see “Modifying a
Recording,” beginning on page 34.

•

Modify attributes associated with an object in the Action Tree. For more
information, see “Working with Action Tree Objects,” beginning on page 37.

3. When done modifying your project, save and close it.

26
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Using the Recorder
The Legacy Integrator SDK records screen traversal and the insertion and extraction of
data from terminal screens. As you exercise a sequence of host interactions, the
interactions are recorded and appear as a series of action item objects in the Action Tree.
When you are done recording, you can modify the objects in the Action Tree, if
necessary. You can also play back the recorded sequence to make sure it is correct.
Each project can contain multiple sequence objects. The interactions recorded in all
sequences in a project are governed by the host and port values, session type, and other
project information specified in the session object attributes. To commence a recording
sequence, an existing sequence must be selected or you can create one. If no sequence
is selected at the point that the record button
is pressed, a new sequence window
will be presented automatically. This example steps you through creating a sequence
manually.

Creating an Action Sequence Object
1. To add a sequence object to your session, do either of the following:
•

Select the session object, and then open the Edit menu and choose Add
Action Sequence.

•

Right-click on the session object to open the session object context menu,
and then choose Add Action Sequence.

The New Action Sequence dialog box opens.

2. You can modify the sequence name and add a description if you care to, then
click Ok.
The new sequence object appears in the Action Tree.
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Recording a Sequence
1. Select the sequence object in the Action Tree that will contain the recording.
3. The next steps depend on whether or not you want to include the initial
connection to the host in your recording.

•

To include the connect action in your recording:
a. Click
b. Click

to start recording.
to establish a connection with the host.

Data appears on the terminal panel when your connection to the host is
established.
c.
•

Click once on the terminal screen, then begin interacting with the host.

To begin recording after connecting to the host:
a. Click

to establish a connection with the host.

Data appears on the terminal panel when your connection to the host is
established.
b. Click once on the terminal screen. You can navigate to any desired
terminal screen before you begin recording.
c.

Click

to start recording.

Legacy Integrator SDK records your terminal session. Action item objects
representing your interactions with the host will appear under the sequence
object in the Action Tree.

Extracting Data
1. While recording, navigate to the terminal screen from which you want to extract
data.

28
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2. On the terminal screen, click and drag with the mouse to draw a yellow box
around the field from which you want to extract data.

3. Click

.
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The Insert Extract Data dialog box appears.

•

The row and column coordinates shown in the dialog box reflect the location
and dimension of the box you drew on the terminal screen. You can change
the coordinates in the dialog box if necessary.

•

In the Destination area of the dialog box, select a variable previously added
to the project, or click New to create a new variable, to hold the data string
captured from the terminal screen. If you create a new variable, a new
variable object appears under the session object in the Action Tree.

4. When you are done specifying location and destination information in the Insert
Extract Data dialog box, click OK.
An extractData() action item object appears under the currently selected
sequence object in the Action Tree.

Inserting Data
1. While recording, navigate to the terminal screen into which you want to insert
data.
2. Click in the screen where you want to insert data.
3. At this point, while recording you have two options:
a. You can simply interact with the terminal as you intend for your session.
The keys sequence you enter will be recorded as Send Key Action Items
containing a static key set that is true to your interaction.
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b. You can manually bring up the Send Keys dialog that offers you the
option of entering a static key set or allows you to refer to a User
Variable from which keys will be sent dynamically depending on the
variable’s value.
The latter option is the only way to associate the keys with a dynamic variable.
Once a Send Keys Action Item is added to a session, the keys sent are always
either a static key set OR a dynamic reference to User Variable. A Send Keys
Action Item cannot be changed from static to dynamic without deleting the Send
Keys Action Item and using the Send Keys dialog again.
This example illustrates the use of the Send Keys dialog while recording.

4. Click

.

The Insert Send Keys dialog box appears.
If the Session Type attribute of your session object specifies TN3270 or
TN5250, the dialog box will include screen coordinates based on cursor location,
for example:

Legacy Integrator SDK User’s Guide
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If the Session Type attribute of your session object specifies VT, the dialog box
will not include screen coordinates, for example:

4. For TN3270 and TN5250 sessions, you may edit the Starting Row and Starting
Column values in the Location area of the dialog box, if necessary.
For TN3270, TN5250, and VT sessions, you must specify the source for the key
data:
•

If you choose Static, type the keys you want to send in the text field.

•

If you choose Dynamic, select a variable previously added to the project, or
click New to create a new variable, to hold the key data you will send to the
host. If you create a new variable, a new variable object appears under the
session object in the Action Tree.

5. Click OK.
A sendKeys() action item object appears under the currently selected
sequence object in the Action Tree. During playback, text is inserted at the
recorded cursor position.

Creating a Trace Log
A trace log records the sequence of method calls or data in a concatenated text file.
1. Before connecting to the host, select Start Trace… in the Trace menu.
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The Start Tracing dialog box appears.

2. In the Type list box, select the type of information you want to trace:
•

Selecting SESSION_TRACE_DS (Data Stream) to log the process methods
invoked during communication between the Legacy Integrator terminal
emulator and the host.

•

Select SESSION_TRACE_TRANSPORT to log the actual bytes and
negotiation information that is passed back and forth between the Legacy
Integrator terminal emulator and the host.

3. In the Level list box, choose the level of information you want to trace:
•

Select TRACE_MINIMUM log basic Transport and Data Stream events.

•

Select TRACE_NORMAL to log basic events plus additional information.

•

Select TRACE_MAXIMUM to log events at the highest level of detail.

4. In the File Output field, specify a name and location for the trace file.
5. Click OK.
Legacy Integrator SDK begins tracing your interactions with the host. You can
stop tracing by disconnecting from the host or by selecting Stop Trace in the
Trace menu.
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Stopping a Recording

Click

to stop recording.

You may now play back your recorded session, modify object properties, or generate
Java code from your session.

Playing Back a Sequence
1. Make sure that you are not currently recording or playing back.
2. In the Action Tree panel, select the sequence object that represents the recorded
sequence that you wish to play back.
3. Make sure you can play back the sequence:
•

If the sequence begins with a connect() action item, be sure that your
machine is capable of connecting to the host.

•

If the sequence does not begin with a connect() action item, connect to the
host and navigate to the appropriate terminal screen before you play back
the sequence.

4. To play back the selected sequence, do either of the following:

Click

to play back the entire sequence.
Legacy Integrator SDK will step through all the action items in the selected
sequence while displaying the corresponding screens in the Terminal Panel
and attributes in the Attributes Table.

•

Click

to step through the selected sequence one action item at a time.

5. To stop playing back, click

.

Modifying a Recording
After you have recorded a sequence, you can modify it by appending additional recorded
action items, or by adding or deleting action items without recording.
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Appending Additional Recorded Actions
1. Make sure that you are not currently recording or playing back.
2. Select the sequence object that represents the recorded sequence to which you
want to append additional recorded actions.
3. Make sure you can play back the sequence:
•

If the sequence begins with a connect() action item, be sure that your
machine is capable of connecting to the host.

•

If the sequence does not begin with a connect() action item, connect to the
host and navigate to the appropriate terminal screen before you play back
the sequence.

4. Click

to replay the sequence.

The sequence will play back through the last action item in the sequence.
5. Click

to resume recording.

New recorded action items will be appended to the existing action item list.

Adding an Action Item without Recording
There are two procedures for adding action items to a recorded sequence, depending on
whether you want to add the action item at the beginning of the sequence or beneath an
existing action item object.
To add an action item beneath an existing action item object:
1. Make sure that you are not currently recording or playing back.
2. Expand the sequence object to display all the action item objects that it contains.
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3. Right-click the action item object after which you want to add a new action item.

4. From the context menu, choose the action item you want to add.
The new action item object appears in the sequence after the selected node. Edit
the action item attributes (in the Attributes Table) if necessary.
To add an action item at the beginning of a recorded sequence:
1. Make sure that you are not currently recording or playing back.
2. Expand the sequence object to display all the action item objects that it contains.
3. Right-click the sequence node itself.

4. From the context menu, choose the action item you want to add. The new item
object appears as the first action in the sequence.
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Deleting an Action Item from a Recorded Sequence
1. Make sure that you are not currently recording or playing back.
2. Expand the sequence object to display all the action item objects that it contains.
3. You can delete an action item object either of two ways:
a. Select the action item object you want to delete and click the Delete button in
the toolbar.
b.
Right-click the action item object you want to delete and choose Delete from the
context menu.

Working with Action Tree Objects
When you record a terminal session, Legacy Integrator SDK records your interactions
with the host as a series of objects in the Action Tree panel. You can also create objects
by right-clicking on a session, sequence, or action item object and choosing an object to
create from a context menu. All objects in a project are displayed in the Action Tree
panel.
When you select an object in the Action Tree, the attributes of the object are displayed in
the Attributes Table. You can modify objects by editing the values of the attributes.
The following sessions explain how to create, delete and modify the four kinds of objects
your project can contain:
•

Session objects

•

Sequence objects

•

Action item objects

•

Variable objects

Working with Session Objects
Each project contains only one session object, which is the root node of the Action Tree.
The session object defines the connection and terminal attributes for all host interactions
in the project.

Creating Session Objects
Legacy Integrator SDK creates a session object when you create a new project.
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Modifying Session Objects
Session attribute values can be viewed and edited in the Attributes Table. The following
tables list attributes common to all terminal types, as well as additional attributes unique
to each terminal type.
Table 1 – Attributes shared by all terminal types
TN3270, TN5250,
and VT Attributes

Description

Default Value

Name

Project name up to 32 characters long.

LISession

Description

Optional project description up to 1024
characters long.

<blank>

Host

IP address of host

IP address must
be specified when
project is opened

Port

Port through which you will interact with the
host.

23

Session Type

TN3270, TN5250, or VT. This is the only
attribute that cannot be edited after the
session object is created.

TN3270

Step Delay

Number of milliseconds between executions
of consecutive action items during playback.

0

Default Timeout

Number of milliseconds that the terminal will
attempt to connect with the host before
timing out.

10000

Note: The Default Timeout defines the
default maximum wait time (in milliseconds)
for all action items that wait for a specific
condition to occur. I.e.: This value is used in
all WaitForXxx action items dialogs as the
default value for the Timeout field.
Screen Size
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TN3270, TN5250,
and VT Attributes

Description

Default Value

Terminal Panel.
Code Page

The code page table used to map the
EBCDIC character set on the host to the
Unicode character set on the Legacy
Integrator terminal emulator.

CODE_PAGE_US

Table 2 – Unique TN3270 attributes in addition to common attributes
Additional TN3270
Attributes

Description

Default Value

Host Graphics

Indicates whether or not host graphics
functionality is enabled.

false

LU Name

The logical unit name for the Legacy
Integrator terminal emulator.

<blank>

Note: The LU name attribute is not editable
if the TN Enhanced attribute has a value of
“false”.
Number Field Lock

Indicates whether or not to allow a user to
enter only characters 0 through 9, minus
sign, plus sign, period, and comma in fields
defined by a host application as numeric.

true

TN Enhanced

Indicates whether or not Legacy Integrator
will use enhanced telnet negotiation.

false

SSL

Indicates whether or not Legacy Integrator
will communicate over a SSL connection.

false

SSL Protocol

Indicates which SSL protocol will be used:
SSL Ver. 3.0 or TLS Ver. 1.0.

TLS

Note: The SSL Protocol attribute is not
editable if the SSL attribute has a value of
“false”.
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Indicates whether or not Legacy Integrator
will authenticate the server before
connecting to the server.

False

Note: The SSL Server Authentication
attribute is not editable if the SSL attribute
has a value of “false”.
SSL TN Negotiated

Indicates whether or not Legacy Integrator
will execute the SSL Handshake over a
telnet connection or a TLS connection prior
to Telnet negotiations.

False

Note: The SSL TN Negotiated attribute is
not editable if the SSL attribute has a value
of “false”.
SSL P12 File Path

Indicates the absolute file path to the
PKCS#12 file, which contains self-signed
certificates. This attribute should be set if
the solution will be communicating with a
host that uses self-signed certificates, or
certificates from an unknown authority.

<blank>

Note: The SSL PKCS#12 File Path attribute
is not editable if the SSL attribute has a
value of “false”.
SSL P12 Password

Indicates the password to the PKCS#12 file.

<blank>

Note: The SSL P12 Password attribute is
not editable if the SSL attribute has a value
of “false”.

Table 3 – Unique TN5250 attributes in addition to common attributes
Additional TN5250
Attributes
Workstation ID
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Description
Indicates the Workstation ID that is used

Default Value
false
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Additional TN5250
Attributes

Description

Default Value

during enhanced negotiation for 5250.
Table 4 – Unique VT attributes in addition to common attributes
Additional VT
Attributes

Description

Default Value

Auto Wrap

Indicates whether or not auto wrap behavior
is turned on in the Legacy Integrator
terminal emulator.

false

Backspace

Indicates whether a destructive backspace
is used or deleting the character under the
cursor is used.

false

Cursor

Indicates whether or not the host application
controls cursor movement.

false

Keypad

Indicates whether or not the host application
controls the keypad behavior.

false

Local Echo

Indicates whether or not keyboard echo is
turned on.

false

New Line

Indicates how the Legacy Integrator
terminal emulator interprets a new line.

false

Reverse Screen

Indicates whether or not to operate in
reverse video or normal video.

false

Terminal Type

Indicates the type of terminal hardware that
Legacy Integrator emulates.

VT 420 Model 7

VT ID

Indicates the type of terminal the VT
Session is emulating.

vt420

SSH

Indicates whether or not the VT Session
uses the SSH protocol when connecting to
the server.

false
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Description
Indicates the user id to connect as, when
communicating with a SSH Server.

Default Value
<blank>

The SSH User ID must be set when using
either SSH Password Authentication or
SSH Public Key Authentication.
SSH Password

Indicates the password to connect with,
when communicating with a SSH Server.
Used with Password Authentication, but can
also be set when defining a solution that
uses Public Key Authentication.

<blank>

Public Key
Authenticate

Indicates whether or not to use Public Key
Authentication.

false

Public Key Alias

Indicates the public key alias stored in the
keystore. Used with Public Key
Authentication.

<blank>

Public Key
Password

Indicates the password for the public key
alias stored in the keystore. Used with
Public Key Authentication

<blank>

Keystore File Path

Indicates the file path to the keystore. Used
with Public Key Authentication.

<blank>

Please note: The string passed in must use
double backslashes when using a
backslash to separate directories within the
file path. For example,
C:\\Dev\\Administration\\roskeys
tore
Keystore Password
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Indicates the password for the keystore.
Used with Public Key Authentication.

<blank>
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Working with Sequence Objects
Sequence objects represent separate host interactions within the project. Each sequence
object contains action items that define the interaction with the host. Sequence objects
correlate with methods in the Java Bean generated from the project.

Creating Sequence Objects
1. To add a sequence object to your session, do either of the following:
•

Select the session object, and then open the Edit menu and choose Add
Action Sequence.

•

Right-click on the session object to open the session object context menu,
and then choose Add Action Sequence.

The New Action Sequence dialog box opens.

2. You can modify the sequence name and add a description if you care to, then
click Ok.
The new sequence object appears in the Action Tree.

Deleting Sequence Objects
To delete a sequence object, you can do either of the following:
•

Right-click on the object to open the context menu and select Delete.

•

Select the object and click the Delete button in the toolbar.

Modifying Sequence Objects
The following table lists sequence object attributes and values that can be viewed and
edited in the Attributes Table.
Table 5 – Sequence object attributes
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Attribute

Description

Default Value

Sequence Name

Sequence name up to 32 characters long.
Sequence names are automatically assigned
and sequentially numbered by default.

sequence<#>

Sequence
Description

Optional sequence description up to 1024
characters long.

<blank>

Working with Action Item Objects
Action items objects are the contents of sequence objects that specify interactions with
the host. Action items correlate with runtime calls within the methods in the Java Bean
generated from the project.

Creating Action Item Objects
1. Select the sequence object to which you want to add an action item, and then do
either of the following:
•

Open the Edit menu, select Add Action Item, and then choose the action
item you want to add.

•

Right-click on the sequence object to open the sequence object context
menu, and then choose Add Action Item.

If you select Connect or Disconnect, the action item is added at the bottom of
the list of existing action items in the sequence object. If you select another
action item, the respective action item dialog box opens.
2. Complete the dialog box, then click Ok.
The new action item object is added at the bottom of the list of existing action
items in the sequence object.

Deleting Action Item Objects
To delete an action item object, you can do either of the following:
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•

Right-click on the object to open the context menu and select Delete.

•

Select the object and click the Delete button in the toolbar.
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Modifying Action Item Objects
The following table lists action item object attribute values that can be viewed and edited
in the Attributes Table.
Table 6 – Action item attributes
Action Item

Attribute

Default Value

connect()

Start Timeout

disconnect()

No attributes

extractData()

User Variable

Name of the variable.

Start Row

Indicates the starting row position
on the terminal screen where to
start extracting data.

1 (or bounding
box start row
value)

End Row

Indicates the ending row position
on the terminal screen where to
stop extracting data.

1 (or bounding
box end row
value)

Start Column

Indicates the starting column
position on the terminal screen
where to start extracting data.

1 (or bounding
box start
column value)

End Column

Indicates the ending column
position on the terminal screen
where to end extracting data.

1 (or bounding
box end
column value)

Row

Indicates the row position on the
terminal screen where to start
sending input.

1 (or bounding
box row value)

Indicates the column position on
the terminal screen where to start
sending input.

1 (or bounding
box column
value)

sendKeys()

α

Column

α

Description

α

Should this time expire prior to
connection to the host, a
ScreenErr is thrown.

TN3270 and TN5250 sessions only.
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waitForScreen()

waitForCursor()

waitForElapsed
Time()
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Attribute

Description

Default Value

User Variable

Indicates an alternate source that
contains the string that the Send
Keys Action Item will send to the
host.

Keys

Indicates the static string that the
Send Keys Action Item will send
to a host upon playback.

Interval Time

Indicates the interval time to wait
for inactivity between the terminal
screen and the host.

1000

Time Out

Indicates the maximum time to
wait for the host to stop updating
the terminal screen, before a
possible time out exception is
thrown.

10000

Row

Indicates the row position on the
terminal screen where the cursor
is expected to appear.

1

Column

Indicates the column position on
the terminal screen where the
cursor is expected to appear.

1

Time Out

Indicates the maximum time to
wait for the cursor to appear in
the specified position, before a
possible time out exception is
thrown.

10000

Interval Time

Indicates the interval time to wait
for inactivity between the terminal
screen and the host.

1000
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Attribute

Description

Default Value

Time Out

Indicates the maximum time to
wait for the host to stop updating
the terminal screen, before a
possible time out exception is
thrown.

10000

waitForInput()

Time Out

Indicates the maximum time to
wait for input to be uninhibited,
before a possible time out
exception is thrown.

10000

waitForString()

User Variable

Indicates an alternate source that
contains the string that the Wait
For String Action Item will wait for.

Text

Indicates the static string that the
Wait For String Action Item needs
to wait for.

Row

Indicates the row position on the
terminal screen where the first
character is expected to appear.

1

Column

Indicates the column position on
the terminal screen where the first
character is expected to appear.

1

Time Out

Indicates the maximum time to
wait for the specified string to
appear in the specified position,
before a possible time out
exception is thrown.

10000

Working with Variable Objects
Variable objects define the strings sent to, or extracted from, the host during interaction
sequences. Each project can contain multiple variable objects.

Legacy Integrator SDK User’s Guide

47

Chapter 3

Using Legacy Integrator SDK

Creating Variable Objects
1. To add a variable object to your session, do either of the following:
•

Select the session object, and then open the Edit menu and choose Add
Variable.

•

Right-click on the session object to open the session object context menu,
and then choose Add Variable.

The New User Variable dialog box opens.

2. You can modify the variable name and add a description if you care to, then click
Ok.
The new variable object is added under the session object in the Action Tree.

Editing Variable Objects
1. To edit the value of a variable, do either of the following:
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•

Select the variable object, and then open the Edit menu and choose Edit
Variable.

•

Right-click on the variable object to open the variable object context menu,
and then choose Edit Variable.
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The Edit User Variable dialog box opens, displaying the value of the variable.

2. Edit the variable value.
3. When you are done editing the variable, click Ok.

Deleting Variable Objects
To delete a variable object, you can do either of the following:
•

Right-click on the object to open the context menu and select Delete.

•

Select the object and click the Delete button in the toolbar.

Modifying Variable Objects
The following table lists variable object attribute values that can be viewed and edited in
the Attributes Table.
Table 7 – Variable object attributes
Attribute
Variable
Name

Description
Variable name up to 32 characters long. Variable names
are automatically assigned and sequentially numbered
by default.
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Attribute

Description

Default Value

Variable
Description

Optional variable description up to 1024 characters long.

<blank>

Generating a Java Bean from Your Project
Legacy Integrator SDK provides a Bean generation wizard that makes it easy to generate
Java code from your project.

1. Click

.

The Generate dialog box opens.
2. Specify a location and file name for the generated Bean. The filename should
have .java extension when you type in a different name. If you omit it, .java
will blindly be appended.
3. Click Generate.

Note to .NET Bridge Users ONLY:
If you are using the Legacy Integrator SDK with the .NET Bridge product, the SDK will
provide the capability of generating a C# class. Once .NET Bridge is installed, the C#
Class Generation functionality will automatically appear under the Tools menu and in the
toolbar of the SDK. For more information, please see the .NET Bridge User Guide.
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Viewing Field Markers
A field is the fundamental element of the terminal presentation space. For 3270 and 5250
sessions, a Field correlates to the fields defined in their respective data streams. For a
VT session, the entire presentation space is represented in a single field.
The Legacy Integrator SDK provides functionality for viewing the location of fields on a
mainframe application screen. A solid block represents a field marker. The field marker
represents the start of a field. A blue field marker represents a protected field. A
protected field is a field in which the end-user cannot enter input. A red field marker
represents an un-protected field. An un-protected field is a field in which the end-user can
enter input.

To display the field markers, of a screen, the SDK has to be connected to the mainframe.
Once the host is connected to the mainframe then the end-user can toggle the field
marker display, on and off, by:
•

Selecting the View|View Fields menu item.
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Take note that the View|View Fields menu item will also be labeled with a
check mark when the field marker view is enabled.

Field View enabled

Field View disabled

•
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Or, by pressing the Field View toolbar button

.
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Overview
Legacy Integrator SDK includes a powerful runtime API that can be used to modify and
customize the generated Java code. Previous sections discussed how to used the SDK
recorder to build simple host interactions and generate Java code. This section discusses
the methods that make up the runtime API.

The Runtime API
The Runtime API consists of three main classes, TN3270Session, TN5250Session and
VTSession. Once instantiated and initialized, each of these classes is used to connect to
a host application and perform host interactions. The code generated by the SDK uses
only a small portion of the methods available in the API. Often the code generated by the
SDK will need to be customized for a particular application or special task. The user can
take the generated code and customize it with the method calls described below. (NOTE:
The method descriptions given here are brief. Detailed information is available in the
Java docs file: LegacyIntegrator/docs/api/index.html)

The Session Class
This is the main session class from which TN3270Session, TN5250Session, and
VTSession are derived. This is an abstract class and users should instantiate the derived
session object that corresponds to the terminal they are trying to connect as. The class is
discussed here because it contains the core API method calls that are common to all the
different session types.
Void setCodePage(String codePage)
Sets the codePage property. Determines the code page table used to map the
character set on the host to the Unicode character set on the workstation. Each
terminal specific session object defines its own table of valid code pages. (See
the Javadoc for information on specific code pages)
String getCodePage()
Returns the current value of the codePage property.
String getHost()
Returns the current value of the host property.
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Void setHost(String host)
Sets the name of host. Communication between the session and the host will be
started after a call to startCommunication().
int getPort()
Returns the current value of the port property.
void setPort(int port)
Sets the port that will be used to communicate with the host.
int getCommStatus()
Returns the communication status with the host. The possible values are:
Constant

Description

CONNECTION_INIT

Initial state (no connection with host)

CONNECTION_PND_INACTIVE

Stop communications in progress

CONNECTION_INACTIVE

The connection is stopped

CONNECTION_PND_ACTIVE

Start communications in progress

CONNECTION_ACTIVE

Connection is established

CONNECTION_READY

Negotiations started

void startCommunication() Depricated
Starts communications with the host. When the method returns, a valid host
connection has been established and host interaction can begin.
void startCommunication(long waitStartCommTime)
Starts communications with the host. When the method returns, a valid host
connection has been established and host interaction can begin. A ScreenErr
is thrown should the waitStartCommTime expire prior to connection.
void setWaitStartCommTime(long waitStartCommTime)
Support for the deprecated startCommunications() method. See
startCommunication(long waitStartCommTime).
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void stopCommunication()
Stops communications with the host.
void dispose()
Note: Session subclasses may allocate threads that are used during runtime for
emulation and protocol interpretation. If you are dynamically allocating and then
destroying (i.e., making no more references to) a Session, when you are finished
you MUST call dispose() to make sure that you free all resources that Session
was using.
boolean isCommStarted()
Determines whether the connection with the host has been started. This call is
used to determine whether or not host communications has started.
boolean isCommReady()
Checks whether the session is ready for interaction, such as sending keystrokes
or calling other API methods.
void setScreenSize(String screenSize)
Sets the screenSize property. The supported screen size changes based on the
sessionType property. The valid values are:
Constant

Value

SESSION_PS_24X80_STR

"2"

SESSION_PS_32X80_STR

Size (rows x
columns)

3270

5250

VT

24x80
(default)

X

X

X

"3"

32x80

X

SESSION_PS_43X80_STR

"4"

43x80

X

SESSION_PS_27X132_STR

"5"

27x132

X

SESSION_PS_24X132_STR

"6"

24x132

X
X

String getScreenSize()
Returns the current value of the screenSize property.
void setVisible(boolean visible)
Displays the terminal presentation space visible to the user. If “visible” is set to
true, a terminal panel is displayed for debugging purposes.

56

Legacy Integrator SDK User’s Guide

Programmer’s Guide

Chapter 4

java.awt.Panel getTerminalPanel()
Retrieves a java.awt.Panel with the terminal and keypad components based on
the type of terminal.
int getSize()
Returns the linear size of the presentation space. The linear size of a
presentation space is determined by multiplying the number of rows and
columns. For example, a 24 x 80 presentation space would have a size of 1920.
int getSizeRows()
Returns the number of rows represented on the screen.
int getSizeCols()
Returns the number of columns represented on the screen.
int getCursorPos()
Returns the linear cursor position. The linear cursor position is determined by
assuming the presentation space is mapped to a one-dimensional array. Twodimensional array coordinates can be mapped to a one-dimensional array using
the following formula: (y - 1) * numCol + x. Therefore, the linear position of a
cursor at 10, 15 on a 24 x 80 presentation space would be 9*80+15=735.
Note: The cursor positioning system is 1-based rather than 0-based. The valid
cursor positions for a 24 x 80 presentation space are between 1 and 1920
inclusive.
int getCursorRow()
Returns the row coordinate of the current cursor position.
Note: The cursor positioning system is 1-based rather than 0-based. The valid
cursor row positions for a 24 x 80 presentation space are between 1 and 24
inclusive.
int getCursorCol()
Returns the column coordinate of the current cursor position.
Note: The cursor positioning system is 1-based rather than 0-based. The valid
cursor column positions for a 24 x 80 presentation space are between 1 and 80
inclusive.
void setCursorPos(int position)
Sets the cursor position to the specified linear position.
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void setCursorPos(int row, int col)
Sets the cursor position to the specified coordinate position.
void sendKeys(String keys)
Sends a string of keys to the presentation space. The string can be thought of as
keystrokes from the keyboard that can contain both text characters and special
keystrokes, such as the Enter key, the Tab key, or the Page Up key. These
special keys are represented by keywords, which are delimited by square
brackets and called mnemonics. For example, the mnemonic keyword for the
Enter key is [enter].
The text string can contain any number or combination of characters and
mnemonics. For example, you can use "userID[tab]password[enter]" to send a
user's ID, tab to the next field, send the user's password, and then send the
Enter key to logon to a host.
Note: All bracketed special key mnemonics listed in the table below must be
entered in the lower case in which they are shown. These special keys are case
sensitive!
To send a left or right square bracket, the character must be doubled. To send a
left square bracket, use "[[". To send a right square bracket, use "]]".
The following table shows the defined sendKeys() mnemonics.
Table 8 - SendKeys Mnemonic Keys
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Function

Mnemonic Keyword

3270

5250

Attention

[attn]

X

X

Alternate View

[altview]

X3

X3

Backspace

[backspace]

X

X

Backtab

[backtab]

X

X

Beginning of Field

[bof]

X

X

Clear

[clear]

X

X

X1

Cursor Down

[down]

X

X

X1

Cursor Left

[left]

X

X

X1

Cursor Right

[right]

X

X

X1

Cursor Select

[cursel]

X

X

X1

4

VT

X1
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Function

Mnemonic Keyword

3270

5250

VT

Cursor Up

[up]

X

X

X1

Delete Character

[delete]

X

X

X1,2

Display SO/SI

[dspsosi]

X3

X3

DUP Field

[dup]

X

X

X

X

X
X1,2

4

Enter

[enter]

End of Field

[eof]

X

X

Erase EOF

[eraseeof]

X

X

Erase Field

[erasefld]

X

X

Erase Input

[erinp]

X

X

Field Exit
Field Mark
Field Minus
Field Plus

4

[fldext]

[fieldmark]
[field-]

X
4

X

4

[field+]

X
X

4

X

[pf1]

4

X

X

X

F2

[pf2]

4

X

X

X

F3

[pf3]

4

X

X

X

[pf4]

4

X

X

X

[pf5]

4

X

X

X

[pf6]

4

X

X

X

[pf7]

4

X

X

X

[pf8]

4

X

X

X

[pf9]

4

F1

F4
F5
F6
F7
F8
F9

X

X

X

F10

[pf10]

4

X

X

X

F11

[pf11] 4

X

X

X

F12

[pf12]

4

X

X

X

[pf13]

4

X

X

X

[pf14]

4

X

X

X

F13
F14
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3270

5250

VT

[pf15]

4

X

X

X

F16

[pf16]

4

X

X

X

F17

[pf17]

4

X

X

X

[pf18]

4

X

X

X

[pf19]

4

X

X

X

[pf20]

4

X

X

X

[pf21]

4

X

X

[pf22]

4

X

X

[pf23]

4

X

X

F24

[pf24]

4

X

X

Help

[help]

Home

[home]

X

X

X1,2

Insert

[insert]

X

X

X1,2

Keypad 0

[keypad0]

X

Keypad 1

[keypad1]

X

Keypad 2

[keypad2]

X

Keypad 3

[keypad3]

X

Keypad 4

[keypad4]

X

Keypad 5

[keypad5]

X

Keypad 6

[keypad6]

X

Keypad 7

[keypad7]

X

Keypad 8

[keypad8]

X

Keypad 9

[keypad9]

X

Keypad Dot

[keypad.]

X

Keypad Enter

[keypadenter]

X

Keypad Comma

[keypad,]

X

Keypad Minus

[keypad-]

X

F15

F18
F19
F20
F21
F22
F23
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Mnemonic Keyword
[newline]

4

3270

5250

X

X

X

X

VT

PA1

[pa1]

4

PA2

[pa2]

4

X

X

PA3

[pa3]

4

X

X

Page Up

[pageup] 4

X

X

X1,2

Page Down

[pagedn] 4

X

X

X1,2

Reset

[reset] 4

X

X

X

X

X

X

X

System Request

[sysreq]

Tab Field

[tab]

Test Request

[test]

4

X1

X

1

VT supports this function but it is up to the host application to act on it.

2

Supported in VT200 mode only.

3

The function is only available in a DBCS session.

4

Ends a sendKeys() action while recording.

void sendKeys(String keys, int pos)
Sends a string of keys to the presentation space. The string can be thought of as
keystrokes from the keyboard that can contain both text characters and special
keystrokes, such as the Enter key, the Tab key, or the Page Up key. These
special keys are represented by keywords, which are delimited by square
brackets and called mnemonics. For example, the mnemonic keyword for the
Enter key is [enter].
The text string can contain any number or combination of characters and
mnemonics. For example, you can use "userID[tab]password[enter]" to send a
user's ID, tab to the next field, send the user's password, and then send the
Enter key to logon to a host.
To send a left or right square bracket, the character must be doubled. To send a
left square bracket use "[[". To send a right square bracket use "]]".
This signature of SendKeys sends the given text string at the specified cursor
location.
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void sendKeys(String keys, int row, int column)
Sends a string of keys to the presentation space. The string can be thought of as
keystrokes from the keyboard that can contain both text characters and special
keystrokes, such as the Enter key, the Tab key, or the Page Up key. These
special keys are represented by keywords, which are delimited by square
brackets and called mnemonics. For example, the mnemonic keyword for the
Enter key is [enter].
The text string can contain any number or combination of characters and
mnemonics. For example, you can use "userID[tab]password[enter]" to send a
user's ID, tab to the next field, send the user's password, and then send the
Enter key to logon to a host.
To send a left or right square bracket, the character must be doubled. To send a
left square bracket use "[[". To send a right square bracket use "]]".
This signature of SendKeys sends the given text string at the specified cursor
location.
String getString(int bufferLength)
Retrieves text from the presentation space and removes duplicate DBCS
characters before the text is returned. The application must supply the length of
the buffer. Data is returned starting from the beginning of the presentation space
and continuing until the buffer is full or the entire presentation space has been
copied.
String getString(int pos, int bufferLength)
This method retrieves text from the presentation space as a String object.
Text is returned starting from the given linear position and continuing until the
specified number of characters has been copied or until the entire presentation
space has been copied.
String getString(int startRow, int startCol, int bufferLength)
This method retrieves data from the presentation space as a String object.
Data is returned starting from the given coordinate and continuing until the
specified number of characters has been copied or until the entire presentation
space has been copied.
String[] getStringInRect(int startPos, int endPos)
This method retrieves text from the presentation space as an array of String
objects representing each row of data from within the bounding rectangle.
The application supplies two positions that represent opposing corners of a
rectangle within the presentation space. The starting and ending positions can
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have any spatial relationship to each other. The data returned starts from the row
containing the upper-most point to the row containing the lower-most point, and
from the left-most column to the right-most column.
String[] getStringInRect(int startRow, int startCol, int endRow, int endCol)
This method retrieves text from the presentation space as an array of String
objects representing each row of data from within the bounding rectangle.
The application supplies two coordinates that represent opposing corners of a
rectangle within the presentation space. The starting and ending coordinates can
have any spatial relationship to each other. The text returned starts from the row
containing the upper-most point to the row containing the lower-most point, and
from the left-most column to the right-most column.
void setString(java.lang.String text)
Sends a string to the presentation space at the current cursor location.
Functionally identical to setText, except for the way it handles DBCS characters.
While setText copies the given string directly to the presentation space, setString
automatically duplicates DBCS characters before copying the string to the
presentation space. The modified string will overlay only unprotected fields, and
any parts of the string that fall over protected fields will be discarded.
Note: setString functions identically to setText when the text contains no DBCS
characters.
void setText(java.lang.String text)
Sends a string to the presentation space at the current cursor location. The string
will overlay only unprotected fields, and any parts of the string that fall over
protected fields will be discarded.
void setString(String text, int pos)
Sends a string to the presentation space at the linear position passed in.
Functionally identical to setText, except for the way it handles DBCS characters.
While setText copies the given string directly to the presentation space, setString
automatically duplicates DBCS characters before copying the string to the
presentation space. The modified string will overlay only unprotected fields, and
any parts of the string which fall over protected fields will be discarded.
Note: setString functions identically to setText when the text contains no DBCS
characters.
void setText(String text, int pos)
The setText method sends a string to the presentation space at the specified
location. The string will overlay only unprotected fields, and any parts of the
string that fall over protected fields will be discarded.
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void setString(String text, int row, int col)
The setString method sends a string to the presentation space at the specified
location. Functionally identical to setText, except for the way it handles DBCS
characters. While setText copies the given string directly to the presentation
space, setString automatically duplicates DBCS characters before copying the
string to the presentation space. The modified string will overlay only unprotected
fields, and any parts of the string that fall over protected fields will be discarded.
Note: setString functions identically to setText when the text contains no DBCS
characters.
void setText(String text, int row, int col)
The setText method sends a string to the presentation space at the specified
location. The string will overlay only unprotected fields, and any parts of the
string that fall over protected fields will be discarded.
int convertPosToRow(int pos)
Converts a linear position to its corresponding row value, based on the current
presentation space.
int convertPosToCol(int pos)
Converts a linear position to its corresponding column value, based on the
current presentation space.
int convertRowColToPosition(int row, int col)
Converts a row and column coordinate to its corresponding linear position value,
based on the current presentation space.
void waitForElapsedTime(long interval, long maxTime)
Synchronously waits for a specified interval of time to elapse during which the
presentation space is not updated with data. If the specified interval elapses
without any presentation space updates then this method returns. If the
presentation space is updated during the interval, the wait ends at the maximum
time passed in. If the maximum time is reached, then a MaxTimeOutException is
thrown.
void waitForScreen(long interval, long maxTime)
Synchronously waits for a specified time interval during which the terminal is set
to an inhibited state. (Similar to wait for elapsed time above.)
void waitForCursor(int row, int col, long timeout)
Synchronously waits until the cursor appears at the given row and column
position or until the method times out.

64

Legacy Integrator SDK User’s Guide

Programmer’s Guide

Chapter 4

void waitForString(String text, long timeout)
Synchronously waits until the string appears in the presentation space. Will also
wait until the input is not inhibited. String wait will be case sensitive.
void waitForString(String text, int row, int col, long timeout)
Synchronously waits until the string appears at the given position. Will also wait
until the input is not inhibited. String wait will be case sensitive.
void waitForStringInRect(String text, int startRow, int startCol, int endRow, int endCol,
long timeout)
Synchronously waits until the string appears in the given rectangle. Will also wait
until the input is not inhibited. String wait will be case sensitive.
void waitForString(String text, int row, int col, long timeout, boolean waitForInput,
boolean caseSensitive)
Synchronously waits until the string appears at the given position.
abstract FieldList getFieldList()
Returns an instance of FieldList based on the current presentation space. A field
list contains a collection of the fields in the presentation space. It provides
methods that iterate through the fields and find fields based on location. Each
element of the list is an instance of Field.
boolean isAlphanumeric()
Determines if the field that contains the cursor is an alphanumeric field.
boolean isDBCS()
Determines if current cursor location is a double-byte character.
boolean isNumeric()
Determines if the field that contains the cursor is a numeric-only field.
boolean isInsertMode()
Determines if the keyboard is in insert mode.
Note: Due to limitations in Java this state does not match the true keyboard
insert state. This state is only affected by sending the "[insert]" mnemonic
keyword to the sendKeys() method.
int inputInhibited()
This method returns a value that indicates whether or not input is inhibited. If
input is inhibited, the reason can be determined from the value returned. If input
is inhibited for more than one reason, the highest value is returned. For example,
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if the host is processing an aid key, the INHIBIT_SYSTEMWAIT value is
returned.
Inhibit Indicator

Value

OIA String

INHIBIT_NOTINHIBITED

0

INHIBIT_SYSTEMWAIT

1

"X SYSTEM" or "X []"

INHIBIT_COMMCHECK

2

"X COMMxxx"

INHIBIT_PROGCHECK

3

"X PROGxxx"

INHIBIT_MACHCHECK

4

"X MACHxxx"

INHIBIT_OTHERINHIBIT

5

int getStatusFlags()
This method returns the current status flags of input. The state can be interpreted
using the following bit masks:
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Constant

Value

Meaning

STATE_CONTROLLER_READY

0x00000001

Controller ready

STATE_A_ONLINE

0x00000002

Online with non-SNA
connection

STATE_MY_JOB

0x00000004

Connected to a host
application

STATE_OP_SYS

0x00000008

Connected to SSCP (SNA)

STATE_UNOWNED

0x00000010

Not connected (SNA)

STATE_TIME

0x00000020

Keyboard inhibited

STATE_SYS_LOCK

0x00000040

System lock after AID key
pressed

STATE_COMM_CHECK

0x00000080

Communication check

STATE_PROG_CHECK

0x00000100

Program check (error in
data stream)

STATE_ELSEWHERE

0x00000200

Keystroke in wrong place
on the screen, cursor must
be moved
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Constant

Value

Meaning

STATE_FN_MINUS

0x00000400

Function currently not
available

STATE_WHAT_KEY

0x00000800

Keystroke invalid at this
time

STATE_MORE_THAN

0x00001000

Too many characters
entered into field

STATE_SYM_MINUS

0x00002000

Symbol entered is not
available

STATE_INPUT_ERROR

0x00004000

Operator input error (5250)

STATE_DO_NOT_ENTER

0x00007FE0

Do no enter mask

STATE_INSERT

0x00008000

ECL Insert state

STATE_GR_CURSOR

0x00040000

Graphic Cursor state

STATE_COMM_ERR_REM

0x00200000

Communications error
reminder

STATE_MSG_WAITING

0x00400000

Message waiting indicator
(5250)

STATE_ENCRYPT

0x80000000

Encrypted session
indicator

void waitForInput(long timeout)
For the time passed in, synchronously waits until the input is not inhibited.
abstract void startTrace(String traceComponent, int traceLevel,
BufferedOutputStream traceStream)
This method takes in trace components and starts tracing. Tracing can be
enabled on one of the following components:
Constant

Component

SESSION_TRACE_DS

DataStream and subcomponents

SESSION_TRACE_TRANSPORT

Transport and subcomponents

Tracing levels that can be set are:
Constant

Description
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TRACE_NONE

Turn trace off

TRACE_MINIMUM

Turn trace on at lowest volume of trace msgs

TRACE_NORMAL

Turn trace on at normal volume of trace msgs

TRACE_MAXIMUM

Turn trace on at maximum volume of trace msgs

abstract void stopTrace()
Stops all logging of trace information. If tracing is not enabled, this method does
nothing.
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The TN3270Session Class
This class is used to connect as an IBM 3270 terminal. In addition to the methods
provided by the Session class, the following 3270 specific methods are available.
boolean isDeviceNameReady()
Checks whether the negotiated device name is ready.
String getDeviceName()
Returns the device (or LU) name associated with this session. The host assigns
the name during session negotiation.
void setTNEnhanced(boolean enhanced)
Sets the TNEnhanced property. Enhanced session (TN3270E) parameters can
be enabled with this method.
boolean isTNEnhanced()
Returns the current value of the TNEnhance property.
void setLUName(String luName)
Sets the LUName property. This property is only valid when the TNEnhanced
property is true.
boolean isValidLUName(String luName)
Returns whether or not the passed LU name is valid.
String getLUName()
Returns the current value of the LUName property.
void setHostGraphics(boolean hostGraphics)
Sets the hostGraphics property. This indicates whether to enable the host
graphics functionality.
boolean isHostGraphics()
Returns the value of the hostGraphics property.
void setNumericFieldLock(boolean numericFieldLock)
Sets the Numeric Field Lock property of Session. When true, only characters 0
through 9, -, +, period, and comma are allowed in fields defined by a host
application.
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boolean isNumericFieldLock()
Returns the value of the Numeric Field Lock property.
boolean isCommErrorReminder()
This method reports on the status of the communications error reminder
condition.
IScreenAttribute getScreenAttribute(int row, int col)
Retrieves an instance of IScreenAttribute representing the attributes of the
coordinates passed in.
FieldList getFieldList()
Returns an instance of FieldList based on the current presentation space. A field
list contains a collection of the fields in the presentation space. It provides
methods that iterate through the fields and find fields based on location. Each
element of the list is an instance of Field.
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The TN5250Session Class
This class is used to connect as an IBM 5250 terminal. In addition to the methods
provided by the Session class, the following 5250 specific methods are available.
String getWorkstationID()
Returns the name of a workstation ID for this session.
boolean isValidWorkstationID(String workstationId)
Tests the given workstationID for correct syntax. This method is called by
setWorkstationID. If this method returns false, setWorkstationID throws a
PropertyVetoException.
boolean isWorkstationIDReady()
Checks whether the negotiated workstation ID is ready.
void setWorkstationID(String workstationId)
Sets the workstationID property.
boolean isMessageWaiting()
This method reports on the status of the message waiting indicator.
IScreenAttribute getScreenAttribute(int row, int col)
Retrieves an instance of iScreenAttribute representing the attributes of the
coordinates passed in.
FieldList getFieldList()
Returns an instance of FieldList based on the current presentation space. A field
list contains a collection of the fields in the presentation space. It provides
methods that iterate through the fields and find fields based on location. Each
element of the list is an instance of Field.
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The VTSession Class
This class is used to connect as a VT terminal. The terminal supports VT52, VT100,
VT220 and VT420 emulation modes. In addition to the methods provided by the Session
class, the following VT specific methods are available.
boolean isVTAutoWrap()
Returns the value of the VTAutowrap property.
void setVTAutoWrap(boolean autoWrap)
Sets the VTAutowrap property.
Constant

Description

"false"

Off (default)

"true"

On

void setVTKeypad(boolean keypad)
Sets the VTKeypad property. Determines the behavior of the keypad.
Constant

Description

"false"

Normal (default)

"true"

Application controls keypad behavior

boolean isVTKeypad()
Returns the value of the VTKeypad property.
void setVTCursor(boolean application)
Sets the VTCursor property.
Constant

Description

"false"

Off (default)

"true"

Application controls cursor movement

boolean isVTCursor()
Returns the value of the VTCursor property.
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void setVTLocalEcho(boolean localEcho)
Sets the VTLocalEcho property. Determines the behavior of local keyboard echo.
Constant

Description

"false"

Off (default)

"true"

On

boolean isVTLocalEcho()
Returns the value of the VTLocalEcho.
void setVTBackspace(boolean backspace)
Sets the VTBackspace property.
Constant

Description

"false"

Destructive backspace (default)

"true"

Delete character under cursor

boolean isVTBackspace()
Returns the value of the VTBackspace property.
void setVTNewLine(boolean newLine)
Sets the VTNewLine property. Determines the behavior of new line operation.
Constant

Description

"true"

Carriage return only (CR) (default)

"false"

Carriage return and linefeed (CRLF)

boolean isVTNewLine()
Returns the current value of the VTNewLine property.
void setVTReverseScreen(boolean reverseScreen)
Sets the VTReverseScreen property. Determines the behavior of the display.
Constant

Description

"true"

Reverse video is set

Legacy Integrator SDK User’s Guide

73

Chapter 4

"false"

Programmer’s Guide

Normal video is set.

boolean isVTReverseScreen()
Returns the value of the VTReverseScreen property.
void setVTTerminalType(String terminalType)
Sets the VTTerminalType property. The valid values are:
Constant

Description

SESSION_VT_TERMINAL_TYPE_VT420_7

VT420 Model 7(default)

SESSION_VT_TERMINAL_TYPE_VT420_8

VT420 Model 8

SESSION_VT_TERMINAL_TYPE_VT220_7

VT220 7-bit

SESSION_VT_TERMINAL_TYPE_VT220_8

VT220 8-bit

SESSION_VT_TERMINAL_TYPE_VT100

VT100

SESSION_VT_TERMINAL_TYPE_VT52

VT52

String getVTTerminalType()
Returns the current value of the VTTerminalType property.
void setVTID(String vtID)
Sets the VT ID used to identify the session with the host. The end user may enter
in a string that represents the VT ID, for example “vt420”, or the end user may
use one of the following constants:
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Constant

Description

SESSION_VT_ID_VT420

vt420 (default)

SESSION_VT_ID_VT320

vt320

SESSION_VT_ID_VT220

vt220

SESSION_VT_ID_VT102

vt102

SESSION_VT_ID_VT101

vt101

SESSION_VT_ID_VT100

vt100
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IScreenAttribute getScreenAttribute(int row, int col)
Retrieves an instance of iScreenAttribute representing the attributes of the
coordinates passed in.
FieldList getFieldList()
Returns an instance of FieldList based on the current presentation space. A field
list contains a collection of the fields in the presentation space. It provides
methods that iterate through the fields and find fields based on location. Each
element of the list is an instance of Field.

Legacy Integrator SDK User’s Guide

75

Chapter 4

Programmer’s Guide

Fields and Attributes
A field is the fundamental element of the terminal presentation space. A field includes
both content and attribute information. The abstract Field class encapsulates a
presentation space field and provides methods for accessing and manipulating field
attributes and content. For 3270 and 5250 sessions, a Field object correlates to the fields
defined in their respective data streams. For a VT session, the entire presentation space
is represented in a single field. Field objects can be accessed through FieldList objects,
which are retrieved from the respective Session object.
For example, given a 3270Session object connected to a host, the list of fields defined in
the current presentation space can be iterated over as shown below:
public void dumpFields() throws ScreenErr
{
int cnt = 1;
Field field = null;
FieldList list = session.getFieldList();
field = list.getFirstField();
while (field != null)
{
System.out.println();
System.out.print("Field " + cnt + "@(");
System.out.print(field.getStartRow() + ",");
System.out.print(field.getStartCol() + ")");
System.out.print(" length=" + field.getLength());
System.out.print(" protected=" + field.isProtected());
System.out.print(" display=" + field.isDisplay());
field = list.getNextField(field);
cnt++;
}
}

This sample code iterates over the defined fields, dumping the field location and some
attribute values. The Field and FieldList classes are useful when the user needs
more than just textual information from the terminal presentation space.
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Variable Output and XML
The Legacy Integrator Runtime provides support for outputting the variables in an XML
string. This functionality is provided through the BaseIntegrationSession class. All
Integration Solution Session Beans generated by the Legacy Integrator SDK extends the
BaseIntegrationSession class. This class maintains all the variables created during the
recording process of the SDK. The BaseIntegrationSession class also provides the ability
to output all variables into an XML String.
An integration solution can extend the BaseIntegrationSession class and use this class to
maintain the variables used by the integration solution and grab the values of the
variables through an XML string.
The BaseIntegrationSession class requires that all variables be set and accessed
through the following two methods:
String[] getVariable(String varKey)
Retrieves the value associated with the variable key that is passed in.
void setVariable(String varKey, String[] varValue)
Saves the variable and that value passed in. Using setVariable the developer is
expected to use the variable name as the varKey parameter.
Once the variables of a class are set an integration solution can then use the method
below to output the variables as an XML String.
String getVariablesAsXML()
Returns a string of all the variables that were created along with the value of
each variable. The string will represent the variables and the associated values in
an XML Format. The XML format will exist as:
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<?xml version="1.0"?>
<classname>
<variablename>
<element0>...</element0>
<element1>...</element1>
...
</variablename>
...
</classname>
The above tag "classname" will be replaced by the name of the Session class
generated by the Legacy Integrator SDK. The "variablename" tags will each be
replaced by each variable name created in the Legacy Integrator SDK.
Since each variable value is represented in a String array, the <variablename>
tag will be followed by a list of <element#> tags. Each <element#> tag will
represent an element in the variable's String array.

Error and Exception Handling
There are three types of exception objects that are thrown by the runtime during normal
execution. Each method in the runtime may throw one or more of these exceptions. You
must make sure that each exception is either caught or handled appropriately.

Timeout Exceptions
The MaxTimeOutException indicates that a particular event failed to occur in the time
allowed. All of the “waitFor” methods will throw this exception when the given time period
expires. Depending on the circumstances, this may or may not be an error.
Timeout exceptions can occur because of a slow network connection or heavily loaded
host application. It is not unusual for timeouts to occur occasionally or even rarely. You
may need to experiment to determine an appropriate timeout interval. As you become
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more familiar with the host application, you will be better able to “fine tune” the wait
periods for your code.

Screen Errors and Runtime Exceptions
ScreenErr and LIRuntimeException objects are thrown when an internal error
occurs in the terminal emulator. ScreenErr exceptions relate to the internal emulator’s
presentation space. For example, when a user specifies an invalid screen position or
location, a ScreenErr is thrown. The LIRuntimeException is used for any other
internal error that is not necessarily related to the visual presentation space.

Running Applications
The code that Legacy Integrator generates is pure Java. It can be compiled and executed
as any other Java code would be and offers complete platform independence. In order for
the applications to function correctly, however, you must make proper use of the runtime
class library.

Using the Runtime Class Library
The runtime class library is the portion of Legacy Integrator required to run the classes
you create in the SDK. It includes all of the classes that the TN3270Session,
TN5250Session and VTSession classes use to communicate to a corresponding host
machine. You must include all of these classes with your own in order for the terminal
portions of your applet or application to function correctly.

Importing Packages to Use the Runtime
To run the applets and applications created with the Legacy Integrator SDK, you must
import the com.redoaksw.legacy.runtime class package included in the
sdkruntime.jar file. The jar files for all imported files must be in the classpath when you
compile and run your code. The sdkruntime.jar file is contained in the LegacyIntegrator/lib
directory created during installation.
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Overview
This chapter presents a step-by-step tutorial through the process of creating a simple
application with Legacy Integrator SDK. The Library of Congress search application you
will build consists of two classes, LibrarySession and LocAccess. LibrarySession is
created using Legacy Integrator SDK to record interactions with the Library of Congress
server. LocAccess uses these interactions in a simple command line program.

Creating the LibrarySession Class
Before You Begin
Some of the steps in the following example take longer to complete than others. You may
experience disconnections from the Library of Congress due to timeouts. If this happens,
reconnect to the Library of Congress and return to the screen you were on when you
were disconnected.
If you are disconnected while recording, you can use any sequences already recorded to
quickly and easily return you to your last step before your recording was interrupted.
Simply play back all recorded sequences in the order you recorded them, beginning with
the connect sequence. When you’ve reached the desired point, you can resume
recording.

Recording the Library Session
Create a New Project
1. Click New Project.
The New Project dialog appears.
2. In the Host field, type “locis.loc.gov”.
3. Make sure that session type TN3270 is selected.
4. Change the Name field from “LISession” to “LibrarySession”.
5. Click Create.
A Session object labeled “LibrarySession” appears in the Action Tree.
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Recording the “connect” Sequence
In this section, you record the sequence that connects to the server and waits for a
response from the server before finishing.
1. In the Action Tree, select the LibrarySession object.
2. Select Add Action Sequence from the Edit menu.
The New Action Sequence dialog box opens.
3. Change the name of the sequence from “sequence1” to “connect”.
4. Click Ok.
A new sequence object labeled “connect” appears underneath the
LibrarySession object.
5. Select the new connect object.
6. Click Record.
7. Click Connect.
Legacy Integrator SDK will attempt to connect to the host locis.loc.gov. When it
reaches the host, the terminal screen displays the Library of Congress opening
screen.
8. When the Library of Congress opening screen appears, click Stop.
Several action items appear beneath the connect sequence object in the Action
Tree. The first action item is labeled connect, followed by a number of
waitForScreen action items. The exact number of waitForScreen action items will
vary according to network conditions at the time of recording.

Recording the “bookSearch” Sequence
The connect sequence in the previous section contains a few very basic commands: a
connect command, followed by one or more waitForScreen commands. The next
method, bookSearch, is only slightly more complicated. This method consists of
commands that take you from the Library of Congress menu screen to a database search
screen, where the user can enter information on the book for which they are searching.
1. In the Action Tree, select the LibrarySession object.
2. Select Add Action Sequence from the Edit menu.
3. Change the name of the sequence from “sequence2” to “bookSearch”.
4. Click Ok.
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A new sequence object labeled “bookSearch” appears beneath the “connect”
object in the Action Tree.
5. Select the new bookSearch object.
6. Click Record.
7. To return focus to the terminal window, click on it. The cursor is positioned at the
location of the mouse click, so you’ll need to click to the right of the prompt at the
bottom of the screen to place the cursor in the correct position.
8. Type “1”, and then press the Enter key.
A new screen with the heading “N O T I C E”, appears in the terminal window.
9. Type “6”, and then press the Enter key.
A new screen, with the heading “COPYRIGHT INFORMATION”, appears in the
terminal window.
10. Type “1” at the prompt and press the Enter key.
A new screen, with the prompt “READY FOR NEW COMMAND”, appears in the
terminal window.
11. Click Stop.
The new bookSearch sequence contains the following action items:
2

•

sendKeys() – sends the first “1[enter]” combination

•

waitForScreen() – waits for the first new screen to appear

•

sendKeys() – sends the second “1[enter]” combination2

•

waitForScreen() – waits for the second new screen to appear

Recording the “searchFor” Sequence
In the searchFor step, the user enters search text. This sequence is somewhat more
complex that previous sequences, because it must accommodate different search text
every time. The easiest way to create this sequence is to record a sample search, and
then modify the generated code to take a String argument. This will be described in detail
later. For now, we will just record a basic search sequence.
1. In the Action Tree, select the LibrarySession object.
2

During an automatic recording session multiple sendKeys() actions may be created as in this
case. A sendKeys() action is committed and a new one started should a subset of the special
mnemonic keys be exercised. See Table 8 - SendKeys Mnemonic Keys for the complete list of
Mnemonics. The table indicates the members of the subset that end setKeys() actions.
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2. Select Add Action Sequence from the Edit menu.
The New Action Sequence dialog box opens.
3. Change the name of the sequence from “sequence3” to “searchFor”.
4. Click Ok.
A new sequence object labeled “searchFor” appears beneath the bookSearch
object.
5. Select the new searchFor object.
6. Click Record.
7. Click in the terminal window so that the cursor is positioned just to the right of the
“READY FOR NEW COMMAND: “ prompt.
8. Type “browse test” and press the Enter key.
9. When the next screen appears, click Stop.
The new searchFor sequence contains two action items:
•

sendKeys() – sends the search command

•

waitForScreen() – waits for the results to appear

Recording the “getSearchList” Sequence
This last sequence retrieves information from a defined area on the screen, in this case,
the area of the screen containing the results of the search. The information is stored in a
variable that we will create during the process of building this sequence.
1. In the Action Tree, select the LibrarySession object.
2. Select Add Action Sequence from the Edit menu.
The New Action Sequence dialog box opens.
3. Change the name of the sequence from “sequence4” to “getSearchList”.
4. Click Ok.
A sequence object labeled getSearchList appears beneath the “searchFor” object
in the action tree panel.
5. Select the new getSearchList object.
6. In the terminal window, left-click and drag to form a selection box around the
search result items. The selection box should include the entirety of the lines
beginning with “Bxx”, where xx is a number between 01 and 12.
7. Click Extract Data.
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The Extract Data dialog box opens. It should contain the following values:
•

starting row: 4

•

starting column: 1

•

ending row: 15

•

ending column: 80

8. Click New in the Extract Data dialog box.
The New User Variable dialog box opens.
9. Change the name of the variable from “var1” to “screenData”.
10. Click Ok.
The New User Variable dialog box closes, and a new variable object labeled
screenData appears in the Action Tree immediately beneath the LibrarySession
object.
In the Extract Data dialog box, “screenData” appears in the list box next to the
New button.
11. Click OK in the Extract Data dialog box.
An “extractData()” action item appears in the getSearchList sequence.

Generating Code
This section explains how to create a Java Bean from the sequences recorded in the
previous sections. You will use the Java Bean to build your application.
1. Click the Generate Bean button on the toolbar.
A file selection dialog box opens.
2. Specify a new file name or use the default. Specify the path to the desired
location of the generated file.
3. Click Generate.
Each of sequences in the project is generated as a method in a class named
LibrarySession, which is written out to the file specified in step 2.

Modifying the LibrarySession Class
Warning: Any hand-edited modifications you may have made to the LibrarySession class
will be destroyed if you regenerate the code to the same file.
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The searchFor() Method
In this section, you modify the searchFor method to take a string as an argument. This
will make a dynamic search specification possible at runtime.
1. Change the method signature from searchFor() to searchFor(String
searchText).
2. The first line in the method reads:
session.sendKeys(“browse test[enter]”, 12, 27);
Replace the string “test” with the passed in string, so that the line reads:
session.sendKeys(“browse “ + searchText + “[enter]”, 12, 27);

The setVisible() Method
For debugging purposes, it is helpful to be able to display a terminal window while the
program is executing. To accomplish this, you can call the setVisible() method from the
TN3270Session class.
Look at the constructor for LibrarySession. The last line of the try block is a commentedout call to this method. Instead of uncommenting this line, we are going to add a new
method to make this available to outside classes.
1. Create a new method such that the code looks like this:
public void setVisible(boolean value) {
try {
session.setVisible(value);
}
catch( PropertyVetoException exception ) {
exception.printStackTrace();
}
}
2. Because the setVisible method may throw an exception, you must include a trycatch block to handle it. In this case, the catch statement simply prints out the
stack trace from the exception. The caught exception does not terminate the
program, because the terminal window display is not a vital program function.

Building the LocAccess Class
The next step is to construct a class that will make use of the code you have generated
with Legacy Integrator SDK. The class will contain two methods: findBooks and main.
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The findBooks method takes a string argument and, using the LibrarySession class to
perform a search, returns an array representing the result of that search. The main
method checks arguments, calls the findBooks method, and prints the results.

LocAccess Class Setup
No constructor is necessary for this class.
This class has a public class variable used to determine whether or not to display a
terminal window during the running of the program for debugging purposes:
public class LocAccess {
public static boolean debug = false;

The findBooks() Method
1. findBooks is a public method, taking a single argument representing the terms to
search for.
public static String[] findBooks(final String searchText)
throws Exception {
2. If a search term is not supplied, we want an exception to be thrown.
if( searchText.equals(“”) ){
throw new Exception(“Empty Search Topic.”);
}
3. The objects used to perform the search must be initialized.
LibrarySession session = new LibrarySession();
// make the session visible if in debug mode
if( LocAccess.debug == true ) {
session.setVisible(true) ;
}
4. The next steps are to connect to the host and perform the search. These steps
could fail at several points, so the calls have to be wrapped in try / catch
statements.
// Connect to the host
try{
session.connect();
}
catch( Exception e ) {
throw new Exception(“Connection Failed… try again.”);
}
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// navigate to the search area and submit the query
try{
session.bookSearch();
// perform the search
session.searchFor( searchText );
// store the results of the search
session.getSearchList();
}
catch( Exception e ) {
// if an exception was thrown, we lost the connection
// with the host
throw new Exception( “Interrupted data flow. “ +
“Connection may be lost.”);
}
5. When the search is completed, we want to return the results. Because the
LibrarySession object has already stored the information in a user variable, all
that needs to be done is to return the contents of that variable.
return session.getScreenData();

The main() Method
The main method drives the program. It checks to see if an argument has been supplied,
and, if so, uses that argument as the search term. It then takes the results of that search,
and prints them to the console.
1. Begin the method, and check to make sure that the right number of arguments
has been specified. If not, print a usage statement and quit.
public static void main(String[] args) {
if( args.length != 1 ) {
System.out.println(“Usage: LocAccess search-term”);
System.exit(1);
}
2. Turn on debugging, and print the search header.
LocAccess.debug = true;
System.out.println(“Searching for ‘” + args[0] + “’ in the
Library of Congress.”);
3. Get the results of the search, print them out, and then exit. If an exception was
thrown, print out the associated message instead.
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String[] result = null;
try{
result = findBooks( args[0] );
} catch (Exception e ) {
System.out.println( e );
System.exit(1);
}
// print out the contents of the array
for( int i=0 ; i < result.length ; ++i ) {
System.out.println( result[i] );
}
System.exit(0);

Running From the Command Line
Compile the Files
Using your favorite Java compiler, compile the two files you have just created:
LocAccess.java and LibrarySession.java.
Make sure that the sdkruntime.jar file (located at <LI install>/lib/sdkruntime.jar) is in your
classpath, or the classes will not compile.
•

In a Unix environment (csh type shells):
% setenv CLASSPATH $CLASSPATH:<LI install>/lib/sdkruntime.jar
% javac LocAccess.java LibrarySession.java

•

In a Unix environment (sh type shells):
$

export CLASSPATH=$CLASSPATH:<LI install>/lib/sdkruntime.jar

$ javac LocAccess.java LibrarySession.java
•

In MSDOS:
:\> set CLASSPATH=%CLASSPATH%;<LI Install>\lib\sdkruntime.jar
:\> javac LocAccess.java LibrarySession.java

Running the Program
After compiling the Java files, you can run them from the command line.
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1. Make sure that the <LI install>/lib/sdkruntime.jar file is in your classpath.
2. From the command line, type "java LocAccess <keyword>", where <keyword> is
the term you'd like to search for.
java LocAccess <keyword>
The text "Searching for '<keyword>' in the Library of Congress" appears in the console
window. Then the Legacy Integrator SDK terminal panel appears and runs through the
steps as they were recorded earlier. When the search is finished, the results are printed
onto the console and the program exits.
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Overview
This chapter presents information regarding SSH support within the Legacy Integrator
SDK and the Runtime. The SDK provides SSH protocol support for the VT Terminal.
Along with SDK, the Runtime API has several new methods that will allow the developer
to implement integration solutions that can connect and interact with a host using SSH.

Interacting with SSH
SSH Requirements
Legacy Integrator requires that the JVM be configured with the Java Cryptography
Extension (JCE). JCE is included within JVMs 1.5 and greater.

SSH Support
Legacy Integrator supports SSH Protocol 2.0. The algorithms that are supported are as
follows:
o

o

Encryption:


3des-cbc



aes128-cbc

Data Integrity:


o

Key Exchange


o

hmac-sha1
diffie-hellman-group1-sha1

Public Key:


ssh-dss (same as DSA)



ssh-rsa

The authentication methods that are supported are as follows:
o

Public key

o

Password
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Creating a SSH Project
Creating a SSH Project is accomplished by creating a VT Session and configuring the
attributes for SSH support. There are two authentication methods that are supported by
Legacy Integrator Runtime:
•

Password Authentication

•

Public Key Authentication

There are several configuration options when defining the authentication attributes:
1. The developer configures Password Authentication to connect to the SSH
Server. During Password Authentication, once the user name and password is
verified then the Legacy Integrator Session will connect with the SSH Server.
2. The developer configures Public Key Authentication to connect to the SSH
Server. During Public Key Authentication, once the public key is verified, then the
Legacy Integrator Session will connect with the SSH Server.
3. The developer configures both Password Authentication attributes and Public
Key Attributes. In this configuration the Public Key Authentication takes place
first. If the Public Key Authentication fails, then the Legacy Integrator session will
attempt to use the SSH User ID and Password to connect.
Below are two sets of instructions for creating a Legacy Integrator SSH Project: one for
Password Authentication, and the other for Public Key Authentication.

Creating a New SSH Project using Password Authentication
1. Click New Project.
The New Project dialog appears.
2. Enter the name of the project in the Name field. This will be the name that the
project will be saved as, and the default value of the generated java bean’s class
name. The class name may be modified during Java Bean generation.
3. In the Host field, enter the domain name or IP Address of the SSH Server.
4. In the Port field, enter the port number that the SSH service is listening on. The
default port for SSH is 22, however, check with administrator of the SSH server
to verify which port SSH is listening on. Some administrators may modify the port
to something other than the default for the purpose of security.
5. Make sure that session type VT is selected.
6. Within the attributes table, single click the value field for SSH to display the
combo box. Select true to define the session as SSH.
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7. Within the attributes table, single click the value field for SSH User ID to display
the text editor. Enter the user name that the session will be connecting as.
8. Within the attributes table, single click the value field for the SSH Password to
display the text editor. Enter the password that the session will be connecting
with.
9. At this point, select the Create button; doing so will create the Legacy Integrator
SSH Session that will use Password Authentication to connect the SSH Server.
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Create a New SSH Project using Public Key Authentication
Creating a Legacy Integrator SSH Session that uses public key authentication requires
several different sets of steps:
•

Creating a Public-Private key

•

Creating a VT SSH Session

•

Configuring the SSH Server

The sections that follow, step through the configuration process for each of the above
activities.

Creating a Public-Private Key
The public-private key must be created with the keytool that is distributed with the
JDK. This is a requirement for all environments, including Unix. At this time, public-private
key’s generated with ssh-keygen will not be supported.
The keytool is a multipurpose tool distributed with the JDK. Using the keytool a
developer can create a public-private key, list keys already created, and modify
passwords for the public-private keys that were already generated, along with other
functions.
For the purpose of connecting to a SSH server through Public Key Authentication this
configuration process is primarily focused on generating a key.
In a terminal execute the following command (all as one line):
keytool –genkey
–keystore /home/redoaksw/roskeystore
–alias joedev1
-storepass keystorepass
–keypass joedev1pass
-dname “CN=Joe Dev, OU=Development, O=Red Oak Software,
L=Mountain Lakes, S=New Jersey, C=US”
The above command will generate a keystore, if one has not already been created, along
with a public-private key for “Joe Dev”.
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Creating a VT SSH Session
Once a keystore and public-private key has been created, then a Legacy Integrator SSH
Session needs to be created. The steps below provide the configuration process for
creating a VT SSH Session that will use Public Key Authentication.
1. Click New Project.
The New Project dialog appears.
2. Enter the name of the project in the Name field. This will be the name that the
project will be saved as, and the default value of the generated java bean that is
generated. The class name may be modified during Java Bean generation.
3. In the Host field, enter the domain name or IP Address of the SSH Server.
4. In the Port field, enter the port number that the SSH service is listening on. The
default port for SSH is 22, however, check with administrator of the SSH server
to verify which port SSH is listening on. Some administrators may modify the port
to something other than the default for the purpose of security.
5. Make sure that session type VT is selected.
6. Within the attributes table, single click the value field for SSH to display the
combo box. Select true to define the session as SSH.
7. Within the attributes table, single click the value field for SSH User ID to display
the text editor. Enter the user name that the session will be connecting as.
8. Within the attributes table, single click the value field for Public Key Authenticate
to display the combo box. Select true to define the session as using public key
authentication.
9. Within the attribute table, single click the value field for Public Key Alias to
display the text field. Enter the Public Key Alias value, joedev1.
10. Within the attribute table, single click the value field for the Public Key Password
to display the text field. Enter the Public Key Password, joedev1pass.
11. Within the attribute table, single click the value field for the Keystore File Path to
display the text field. Enter the path to the keystore,
/home/redoaksw/roskeystore (please use the path that is specific to your
environment).
Please note: The string passed in must use double backslashes when using a
backslash to separate directories within the file path. For example,
C:\\Dev\\Administration\\roskeystore
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12. Within the attribute table, single click the value field for the Keystore Password to
display the text field. Enter the password for accessing the keystore,
keystorepass.
13. At this point, select the Create button; doing so will create the Legacy Integrator
SSH Session that will use Public Key Authentication to connect the SSH Server.

At this point, a VT SSH Session will be created that has the proper attributes required
to access the keystore when authenticating with the SSH Server.
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Configuring the SSH Server
In order to use the public key to authenticate with the SSH Server, two actions must take
place:
1. The public key must be exported to the SSH Server.
2. The SSH Server must be configured to access the public key.
a. Note: Please consult the system administrator of your SSH Server to
help with this part of the configuration. Each SSH Server can have
different configuration requirements; consulting the system administrator
can help with any nuances that the following steps might not take into
account.
The steps below discuss the configuration process that needs to take place in order to
properly configure the SSH Server.
1. Within the Legacy Integrator SDK, select the Tools > Export Public Key… menu
item. Doing so will display the Export Public Key dialog.
a. The values contained in Public Key Information cannot be edited. The
information presented is used to verify that all data has been entered
properly. If any modifications are required then they must be made to the
Legacy Integrator’s Session through the attribute table.
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2. Define the location and name of the exported public key file by selecting at the end of
the Export Public Key To field.
3. Select the OpenSSH Format checkbox if the SSH Server uses the OpenSSH
Format. If the SSH Server uses the SSH Public Key File Format, then leave the
OpenSSH Format checkbook un-selected. You may need to consult the system
administrator of the SSH server to determine which format is required.
4. Select the Ok button to confirm all modifications, and generate the public key to be
exported to the SSH Server.
5. Transfer the public key, id_dsa.pub, to the SSH Server that the Legacy Integrator
Session will be connecting to. Please make sure that the public key is transferred to
the account that the SSH Session will be connecting as.
6. SSH into the SSH Server, as the user that the Legacy Integrator session will be
logging in as. For the purpose of these steps, the user account name will be referred
to as joedev.
7. Change the directory to joedev’s home directory by executing the following command
at the prompt:
cd /home/joedev
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8. Create the directory .ssh under /home/joedev. This can be accomplished by
executing the following command at the prompt:
mkdir .ssh
9. Modify the permissions for .ssh to rwx (i.e. rwx------) for the user account. This
can be accomplished by executing the following command at the prompt:
chmod 700 .ssh
a. The permissions can be verified by executing the following command:
ls –lah .ssh
10. Change to the .ssh directory. This can be accomplished by executing the following
command at the prompt:
cd .ssh
11. Copy the public key, id_dsa.pub, into the .ssh directory. This can be
accomplished by executing the following command at the prompt:
cp /home/joedev/id_dsa.pub .
12. Append the public key file, id_dsa.pub, to the file, authorized_keys. This can
be accomplished by executing the following command at the prompt:
cat id_dsa.pub >> authorized_keys
a. Note: if the authorized_keys file does not already exist, then the above
command will create it.
13. Modify the permissions for authorized_keys to rw (i.e. rw_------) for the user
account. This can be accomplished by executing the following command at the
prompt:
chmod 600 authorized_keys
a. The permissions can be verified by executing the following command:
ls –lah authorized_keys
14. At this point, the public key can be deleted from the account. This can be
accomplished by executing the following command at the prompt:
rm id_dsa.pub
At this point, the SSH Server is configured to have the Legacy Integrator SSH Session
connect to it using a public key.
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Deploying a SSH Session
Once the Legacy Integrator SSH solution is completed, the developer will be required to
deploy the Legacy Integrator SSH Session bean to both testing and production
environments. If password authentication is used, no further action is required, other than
normal java based solution deployment. However, if the developed SSH Session was
implemented using public key authentication, then the keystore used during development
must be moved to the planned execution environments. The keystore must be placed
within the account in which the solution will be executing as.
When transferring the keystore, the developer must insure that the same keystore path
configured in the Legacy Integrator SSH Session bean exists in the environment in which
the solution will be executed on.
During implementation, the developer could use the default path:
<user.home>/.keystore when defining the keystore file path. If the keystore file path
is not set (left empty), then the default path will be used by the runtime. If the SSH
solution is implemented using the default keystore path, then reconfiguring the SSH
Session Bean with the new keystore path, becomes unnecessary, when transferring the
keystore and SSH Session bean to the execution environment.
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The SSH Runtime API
The Legacy Integrator SSH Session bean generated with the SDK contains specific
methods for SSH support. These methods can be found within the class VTSession.

SSH Methods
This section lists all methods defined by VTSession to provide SSH support.
void setTerminalToSSH(boolean ssh)
Sets the security protocol for the VTSession as SSH.
Constant

Description

"false"

SSH Protocol is not used (default)

"true"

SSH Protocol is used

boolean isSSH()
Returns whether or not the security protocol is set to use SSH.
void setPKAuthentication(boolean pkAuthenticate)
Specifies whether or not the VTSession will be using public key authentication or
password authentication. The VTSession must be set to use the SSH security
protocol prior to setting the authentication method. If public key authentication is
set, and during execution, the authentication fails, then the VTSession will try
password authentication.
Constant

Description

"false"

Use only Password Authentication (default)

"true"

Use Public Key Authentication

boolean isPKAuthentication()
Returns whether or not public key authentication will be used.
void setSSHPublicKeyAlias(String aliasKey)
Sets the Public Key Alias to the string passed in. This method should be used if
public key authentication is being used to connect to the SSH Server. At the time
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that the runtime tries to connect to the SSH Server, the public key alias that is
passed in will be used. However if the public key alias is not set, then the runtime
will use the default value. The default value used by the Runtime is mykey.
String getSSHPublicKeyAlias()
Retrieves the current value of the public key alias.
void setSSHPublicKeyAliasPassword(String aliasPassword)
Sets the password for the public key alias that is stored in the keystore. The
public key alias password must be set when using public key authentication.
String getSSHPublicKeyAliasPassword()
Returns a String representing the current value of the password for the public key
alias.
void setSSHUserID(String userID)
Sets the user account id that will be used to log into the SSH Server. This must
be the account name that the Legacy Integrator solution will be connecting as.
The SSH User ID must be set for both password, and public key authentication.
String getSSHUserID()
Returns a String representing the current value of the User ID that will be used to
connect to the SSH Server.
void setSSHUserPassword(String userID)
Sets the user account password that will be used to connect to the SSH Server.
This method should be called if the solution will be using password
authentication.
String getSSHUserPassword()
Returns a String representing the current value of the User Password that will be
used to connect to the SSH Server.
void setKeystoreFilePath(String filePath)
Sets file path to the keystore that contains the public-private key. This method
should be called if the solution will be using public key authentication. If the
keystore file path is not set, then the default value for the keystore file path will be
used. The default value of the keystore is <user.home>/.keystore, where
<user.home> represents the file path to the user account of the executing
environment.
Please note: The string passed in must use double backslashes when using a
backslash to separate directories within the file path. For example,
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C:\\Dev\\Administration\\roskeystore
String getKestoreFilePath()
Returns a String representing the current value of the keystore file path.
void setKeystorePassword(String keystorePassword)
Sets the password required to access the keystore that contains the publicprivate key. This method must be called if the solution will be using public key
authentication.
String getKestorePassword()
Returns a String representing the current value of the keystore password.
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Overview
This chapter provides information regarding SSL support within the Legacy Integrator
SDK and the Runtime. The SDK provides SSL protocol support for a TN3270 session.
Along with SDK, the Runtime API has several new methods that will allow the developer
to implement integration solutions that can connect and interact with a TN3270 host over
SSL.

Interacting with SSL
SSL Protocol Support
The following protocols are supported:
o

TLS: TLS Protocol Version 1.0.

o

SSL: SSL Protocol Version 3.0.

Creating a SSL Project
Creating a SSL Project is accomplished by creating a new TN3270 Session and
configuring the attributes for SSL support. The TN3270Session allows for basic SSL
authentication and allows for self signed server certificates.
Below is a list of the possible SSL attributes that can be configured:
•

SSL :

•

SSL Security Protocol :

•

SSL Server Authentication

•

SSL TN Negotiations

•

SSL P12 File Path

•

SSL P12 Password
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Creating a TN3270 Basic SSL Project
To configure a TN3270 project and session to communicate over SSL, please follow the
steps below. The steps go through the configuration process for setting up a Session for
basic SSL communication.
1. Click New Project.
The New Project dialog appears.
2. Enter the name of the project in the Name field. This will be the name that the
project will be saved as, and the default value of the generated java bean’s class
name. The class name may be modified during Java Bean generation.
3. In the Host field, enter the domain name or IP Address of the server.
4. In the Port field, enter the port number. The default port for SSL is 992, however,
check with administrator of the server to verify which port to configure. Some
administrators may modify the port to something other than the default for the
purpose of security.
5. Make sure that session type TN3270 is selected.
6. Within the attributes table, single click the value field for SSL to display the
combo box. Select true to define the session as SSL.
7. (Optional) Within the attributes table, single click the value field for SSL Security
Protocol to display the text editor. Select TLS.
8. At this point, select the Create button; doing so will create the Legacy Integrator
TN3270 Session that will use a SSL connection to connect to the server.
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Create a New SSL Project using Self-Signed Certificates
To configure a Legacy Integrator TN3270 Session that uses SSL with a self-signed
certificate please follow the steps below. This process requires that the administrator
provide the developer with a certificate that can be placed within a PKCS#12 file. Legacy
Integrator uses the PKCS#12 file format for self-signed certificates.
If a PKCS#12 file cannot be created, please contact Red Oak Support
(support@redoaksw.com).
The sections that follow, step through the configuration process for each of the above
activities.
1. Click New Project.
The New Project dialog appears.
2. Enter the name of the project in the Name field. This will be the name that the
project will be saved as, and the default value of the generated java bean’s class
name. The class name may be modified during Java Bean generation.
3. In the Host field, enter the domain name or IP Address of the server.
4. In the Port field, enter the port number. The default port for SSL is 992, however,
check with administrator of the server to verify which port to configure. Some
administrators may modify the port to something other than the default for the
purpose of security.
5. Make sure that session type TN3270 is selected.
6. Within the attributes table, single click the value field for SSL to display the
combo box. Select true to define the session as SSL.
7. (Optional) Within the attributes table, single click the value field for SSL Security
Protocol to display the text editor. Select TLS.
8. Within the attributes table, single click the value field for SSL P12 File Path to
display the text editor. Enter the absolute path and PKCS#12 file name.
For Example: C:\Dev\SelfSignedCertificates.p12
9. Within the attributes table, single click the value field for SSL P12 Password to
display the text editor. Enter the password used to access the PKCS#12 file.
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10. At this point, select the Create button; doing so will create the Legacy Integrator
TN3270 Session that will use a SSL connection and the self-signed certificate to
connect to the server.
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Deploying a TN3270 SSL Session
Once the Legacy Integrator SSL solution is completed, the developer will be required to
deploy the Legacy Integrator SSL Session bean to both testing and production
environments. If basic SSL is used, no further action is required, other than normal java
based solution deployment. However, if the developed SSL Session was implemented
using a self-signed certificate, then the PKCS#12 file that contains the self-signed
certificate, used during development, must be moved to the planned execution
environments.
When transferring the PKCS#12 file, the developer must insure that the same absolute
path configured in the Legacy Integrator SSL Session bean exists in the environment in
which the solution will be executed on. Or the developer must update the SSL Session
Bean with the appropriate path once the solution is transferred to the execution
environment.
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The TN3270Session SSL Runtime API
The Legacy Integrator TN3270 Session bean generated with the SDK contains specific
methods for SSL support. These methods can be found within the class TN3270Session.

SSL Methods
This section lists all methods defined by TN3270Session to provide SSL support.
void setSSL(boolean ssL)
Configures the Session instance to use SSL when communicating with the host.
Constant

Description

"false"

SSL Protocol is not used (default)

"true"

SSL Protocol is used

boolean isSSL()
Returns true if the Session is configured to communicate with the host using
SSL. Returns false if the Session is not configured to use SSL.
void setSecurityProtocol (String protocol)
Configures which security protocol to be used: the TLS protocol or SSL protocol.
The following are the acceptable values that can be passed into this method:
Constant

Description

SECURITY_PROTOCOL_TLS

Use TLS Protocol 1.0 (default)

SECURITY_PROTOCOL_SSL

Use SSL Protocol 3.0

String getSecurityProtocol()
Retrieves the current setting for the Security Protocol (“TLS” or “SSL”).
void setSSLServerAuthentication (boolean authenticate)
Configures the Session that is configured for SSL communication, to authenticate
the server that the Session will be communicating with based on the server name
defined in the certificate.
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boolean isSSLServerAuthentication()
Retrieves whether or not the Session is configured to authenticate a server when
communicating over SSL.
void setSSLTelnetNegotiated (boolean sslTelnetNegotiated)
Configures the Session to execute the SSL Handshake over a Telnet connection
or a TLS connection prior to telnet negotiations. The host telnet server is
expected to support IETF Internet Draft: "TLS-based Telnet Security".
boolean isSSLTelnetNegotiated ()
Retrieves whether or not the Session is configured to execute the SSL
Handshake over a Telnet connection.
void setSSLP12FilePath(String p12FilePath)
Configure the absolute file path to the PKCS#12 file containing the self-signed
certificate.
String getSSLP12FilePath()
Retrieves the configured file path of the PKCS#12 file that contains the selfsigned certificate.
void SSLP12Password(String p12Password)
Configure the password to use when accessing the PKCS#12 file when retrieving
the self-signed certificate.
String getSSP12Password()
Retrieves the current configuration of the password used to access the PKCS#12
file.
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